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Reference Management using EndNote
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By the way …

… any technique may be misused …

Therefore,

… do not import all the references you can find.

… consider creating different reference lists or databases

for different purposes.

… do not cite a document that you have not had a look at.

Ulrich Fischer
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Why citations?

You have to put your research into a context:

 What has been done previously (by others) that is relevant to your

work?

 Which methods that were already available did you use?

 How do your results refer to the results presented by other

researchers?

Ulrich Fischer
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Citation Styles

A number of citation styles are in common use depending on the specific scientific

discipline. The most common styles are APA, Chicago, AMA, and MLA.

Information on citation styles can be found on the web (link 1, 2) and e.g. in the

following book:

Lipson, C. 2005. How to write a BA thesis : a practical guide from your first ideas 

to your finished paper. Chicago University Press. 

http://www.plagiarism.org/citing-sources/citation-styles/
http://www.lib.berkeley.edu/instruct/guides/citations.html
https://eth.swisscovery.slsp.ch/permalink/41SLSP_ETH/lshl64/alma990112992900205503
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The basic features of BMS are importing, storing, searching, citing of

bibliographic references and generating a reference list in an automated

way.

Additional features are commenting on reference entries, searching

databases from the BMS, and adding supplementary information, e.g. 

pictures to an entry, and sharing references with colleagues. 
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Bibliographic Management Systems (BMS)
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There are now quite a number of different BMS. They have different 

features and limitations, some are free while others are commercial

programs, and most are available for several or even all common

computer operating systems.

A comprehensive comparison can be found on the internet in German

and English (you might double-check this information before you base

any decision on it).

08.03.2021Ulrich Fischer 6

Bibliographic Management Systems (BMS)

https://mediatum.ub.tum.de/doc/1271693/1271693.pdf
http://en.wikipedia.org/wiki/Comparison_of_reference_management_software
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EndNote (version 20)

 By Thomson Research Soft

 Probably the leading bibliographic software product on the market.

 EndNote, EndNote Web, EndNote Click

 Many connection files to databases and catalogues are available.

 Highly integrated with Web of Science and Microsoft Word.

 At ETH Zurich available via IT-Shop.

||

 Open an existing EndNote library (.enl): File / Open Library

 Example file Paleo.enl (see Examples folder at C:\Programme\EndNote 20)

 Create a new library: File / New

 Assign a name ‘X’ to the new library

• When creating a new library besides the library itself (X.enl) a data folder

(X.Data) is created
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EndNote – Getting Started

https://idesnx.ethz.ch/
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Edit / Preview / PDF  Window

Library Window Column Headings

Groups

Search Panel

EndNote Library – Basic Elements

Toolbar
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EndNote Library – Toolbar Elements

Add Reference Export
References

Find Full TextShare Group

Create Citation Report
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EndNote Library – Sorting & Finding

 to sort data, click the corresponding column heading

 click twice to reverse the order

 advanced search or sorting options: use the Search Panel

 to find a certain reference, click a column heading and type the first two

letters of e.g. the name of the first author you are looking for

 use * as wildcard when searching

 full texts of attached pdf files can be searched in the Search Panel
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EndNote Library – edit references

 changes in reference entries can be done in the Edit / Preview / PDF  window:

selected
reference

editing
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EndNote Library – PDF editing

 via Summary in the Edit / Preview / PDF Window attached PDFs can be

annotated and text can be highlighted:

annotation

highlighted text
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EndNote – Preferences

The Preferences can be found at the bottom of the Edit menu and comprise

quite a number of options.

The most important options deal with the fields to be displayed in the library

window and the fonts used for this (note that the order of displayed columns can

also be changed by drag & drop).

Another important option is to define exactly how duplicates are checked for.
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EndNote – Creating/Importing References

References might be

 created manually (e.g. via References menu).

 imported from a bibliographic database via an online search within EndNote

(see Tools menu).

 imported from files (e.g. created by exporting references from

bibliographic databases or library catalogues to them; see File menu).

 exported from a database or library catalogue (e.g. swisscovery) directly

to an EndNote library.

 by importing pdf files that contain the DOI
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EndNote – Online Search

Open the online search via Tools menu or toolbar and select the bibliographic

database to be searched. Then use the available search options to retrieve the

references of interest. Note that there are usually more search and import options

available in the database itself. 

https://eth.swisscovery.slsp.ch/discovery/search?vid=41SLSP_ETH:ETH&lang=en
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EndNote – Import References from a File

Open the import interface from the File menu and choose the file to be

imported as well as the options on filters (Import Option), duplicates, and

text translation.

To transfer references from one EndNote library to another: 1) export to text

file 2) import from this.
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EndNote – Importing pdf files

In the Import File  dialog choose the pdf file to be imported as well as the Import 

Option  ‘PDF‘:

The pdf file must contain the DOI to enable identification of the bibliographic

data. Whole folders containing pdf files might be imported.

Ulrich Fischer
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EndNote – Export References from Web of Science

After conducting a literature search in Web of Science (WoS) you can export

either selected references or all references on the page shown and select

EndNote as destination for export:

Ulrich Fischer
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EndNote – Export References from Web of Science

If you did not select single references, also a range can be specified; 

please note: no check for duplicates is conducted with direct export

to EndNote.

Ulrich Fischer

http://isiknowledge.com/wos
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EndNote – Export References from Web of Science

For saving records in a textfile, choose first ‘Save to Other File Formats’ and then

‘Plain Text’:

Ulrich Fischer

Choose ‘ISI-CE‘ as Import Option  in EndNote.

|| 08.03.2021 22

EndNote – Export References from Scopus

Select Records and use the ‘Export’ function:

Ulrich Fischer

Choose

Options

https://www.scopus.com/search/form.uri?display=basic#basic
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EndNote – Export References from Scopus

Unfortunately, with the direct export from Scopus no check for duplicates is

conducted. To enable this option you have to export the selected references to

a textfile named ‘scopus.ris’ after pushing the ‘Export’ (see previous slide) 

button (the detailed procedure might depend on the operating system and web 

browser).

Choose ‘Reference Manager (RIS)‘ as Import Option in Endnote.
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EndNote – Export References from various databases

Also from Ovid a direct export (again without check for duplicates) and an export

via textfile exist. The latter option is the standard for most databases, such as

e.g. PubMed.

The principle is always the same: marking records, perhaps collecting them in a 

basket or marked list within the database, export to textfile, and import of this to

EndNote. Crucial is the right choice of Import Option  (corresponding to the

database from where the references were exported) when importing to EndNote.
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Export References from ETH Library @ swisscovery

References can either be exported one-by-one (use ‘RIS Export’) or several at 

once by using the Favorites:

||

In the E-Shelf (see upper right corner in Search Portal) select references, choose

‘RIS Export’, and save file ‘Primo_RIS_Export.ris’ on your harddisk:

In EndNote use the Import function and choose ‘Reference Manager (RIS)’ as

Import Option.
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Export References from ETH Library @ swisscovery

https://eth.swisscovery.slsp.ch/discovery/search?vid=41SLSP_ETH:ETH&lang=en
https://eth.swisscovery.slsp.ch/discovery/search?vid=41SLSP_ETH:ETH&lang=en
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EndNote – Output Styles

Output styles define in varying degrees of detail the format of the references in 

the text and of the bibliography (list of references), and optionally also of footnotes

(where these are used in the text).

Via Tools / Output Style Manager  many journal templates are available.

Existing styles can be altered and new styles can be created, either from scratch 

or by opening an existing style using the Edit  command, and Save as (File menu) 

with a different name (and changing it afterwards). Many styles are available 

online (http://endnote.com/downloads/styles); after downloading they have to be 

placed in the Styles folder within the EndNote 20 folder.
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EndNote – Term Lists

Term Lists (see Library menu) are each associated with a field entry in the

Reference Window. Term Lists help improve the consistency of manual data 

entries by suggesting terms from the corresponding list while you type.

The Journals Term List  is used to store abbreviations of journal titles, which can 

then be referenced in Output Styles, e.g. according to the requirements of a 

journal (see next slide).

http://endnote.com/downloads/styles
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EndNote – Using (Journal) Abbreviations

Definition of 
abbreviation in Journals 
Term List

Choosing abbreviation in 
selected Output Style
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EndNote – Term Lists

Three empty term lists for authors, journals and keywords are available by 

default with every library. These lists are already linked to their corresponding 

fields.

New lists can be created (Library / Define Term Lists / Create List button), and

new entries can be added to an existing list (Library / Open Term Lists / list 

name, New Term button), e.g. for adding a new journal and its abbreviation to

the Journals Term List.
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In order to import existing term lists for journals, first open the menu Library / 

Open Term Lists / Journals Term Lists and then click on the Lists tab.
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EndNote – Journals Term List

Use the option Import List to

import e.g. the list Chemical.txt

from the following folder: 

C:\Programme\EndNote 

20\Terms Lists
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EndNote – Groups

An Endnote library might be split into subsets of references by defining Groups 

or Smart Groups (the latter are populated automatically). Note that references 

might also be ‘grouped’ by defining keywords (Term List !) for each of them. 

See Groups menu for the Hide Groups option.

Besides the customized groups also such exist that document the status of 

certain actions, e.g. import, online search, or all references cited in a certain 

document.  Entries from different groups can be combined using Boolean 

operators.
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EndNote – Keywords

Adding keywords

to references:

Retrieving/searching references by keywords:
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EndNote – Find Full Text

A file can be attached to a reference via the References menu and the File 

Attachments option (or use right mouse click).

When reference entries in EndNote contain the DOI or similar information

EndNote can download the PDF files automatically by using the Find Full Text

option. A subscription to the journal by ETH and a connection to the ETH 

domain are required.
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EndNote – Find Full Text

Automatically downloaded PDF‘s are stored in the ‘PDF‘ folder within the

corresponding EndNote library folder.

In the Preferences different 

options are available for

automatically renaming

imported PDFs.
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EndNote – Find Full Text

With CWYW you can access EndNote from within Microsoft Word to insert

citations (and also images) into your Word document.

EndNote automatically builds a bibliography of the inserted citations and adds 

this to the Word document.

The format of the citations and the bibliography is defined by the corresponding 

Output Style.
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EndNote – CWYW: inserting citations

In order to insert a citation, first use the Find citation option to identify the

reference(s) to be inserted. To identify a reference, search terms from any 

field of the EndNote library can be used. Select the appropriate reference(s) 

and use the Insert option to introduce them into your text.

References that have already been cited can be edited from Word.
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EndNote – CWYW: formatting citations

By default, EndNote formats the citations in the formatting style that is 

currently in effect (“instant formatting”) and also generates a corresponding 

bibliography automatically. Instant formatting can be turned off in the CWYW 

preferences. 

To change the formatting, the Output Style  has to be changed in the EndNote 

toolbar in Word.

Citations can also be formatted individually.
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If the chosen Output Style  uses as a default e.g. parenthesis around the 

citations, you can change this for individual citations by using the Edit 

Citation(s)  option, selecting a reference …
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EndNote – CWYW: formatting citations
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… checking the Exclude author option, and typing the author name (here: 

‘Clements’ plus ‘et al.’) as plain text. The grey background behind the year 

indicates that this is still a fully linked reference. 

08.03.2021Ulrich Fischer 40

EndNote – CWYW: formatting citations
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Citations in footnotes

When citations are to be placed into footnotes in Word, a footnote has to be 

created first.

Then the citations are inserted into the footnote as they are entered into the 

text.

Two basic options exist for formatting citations in footnotes: ‘Same as citations’ 

or ‘Same as bibliography’. This choice has to be made by editing the 

Footnotes / Templates menu in the selected Output Style (see next slide using 

Author-Date style as an example). Repeated citations can be done in an 

abbreviated form.
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Citations in footnotes

Choose either Same as citations or 

Same as bibliography. The detailed 

definition of the format is then defined 

in either the Citations or Bibliography

menu.
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New Citation Styles from X7 on

In version X7 new citation styles were introduced that allow to sort references 

according to defined categories. This feature is particularly helpful for CVs; in 

Microsoft Word select the style APA 6th CV to obtain an impression of the 

corresponding capabilities; consult the definition of the style to learn how to 

create own categories for another style.

Also topical categories can be added to which the references are assigned 

manually (see Categorize References in the EndNote 20 toolbar in Word).
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Sharing references

References from EndNote libraries can be shared with other people via 

EndNote Web. Everybody involved in the sharing process needs an EndNote 

Web account which can be synchronised with an EndNote desktop library. 

In order to share references the corresponding E-mail addresses have to be 

specified for the groups of references to be shared.
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EndNote Click Browser Extension

EndNote Click (formerly 

Kopernio) identifies 

available full text PDFs 

that are either open 

access or subscribed by 

your institution.
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EndNote Click Browser Extension

The PDF found by 

EndNote Click can be 

transferred together with 

the reference itself to 

EndNote.

For more information on 

EndNote Click see here.

https://click.endnote.com/?referral=W251bGwsMzE5ODMwM10.HuQLrkoxBPR0RUl4-ueuUBrBBUY&utm_source=UserReferral&utm_medium=web&utm_campaign=user-referral&ref=user-referral#register
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Personal recommendations

Conduct the literature search in the database itself (at least for topical or

advanced searches).

Import only selected references to your citation database.

Add your own keywords to each reference.

Double-check that the selected output style meets the requirements of the

journal in question.
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References, Tutorials & Support

 Technical Support & Services at endnote.com link

 Downloads at endnote.com  link

 EndNote Product Training at endnote.com  link

http://www.endnote.com/support/ensupport.asp
http://endnote.com/downloads
http://www.endnote.com/training/
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Questions?

Thank you very much for your attention!

Do you have any questions?
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